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SAP2000 v23.2.0 Release Notes
© 2021 Computers and Structures, Inc.

Notice Date: 18-May-2021

This document lists changes made to SAP2000 since v23.1.0, released 15-March-2021. Items marked
with an asterisk (*) in the first column are more significant.

Analysis
Enhancements Implemented
* Ticket Description
* 5434 An enhancement has been made to improve the consistency of analysis results on Intel and

AMD CPUs with an AVX2 instruction set. Most Intel and AMD CPUs released on 2015 or later
support AVX2 instruction set and should benefit from this enhancement. For nonlinear
analyses of numerically sensitive models, results should be more consistent when run on
different CPUs. For typical well-conditioned models and linear analyses, no significant
change is results is expected.

* 6848 An enhancement has been made to speed up stiffness formation, event determination, and
state update operations for Frame elements in presence of many load patterns. Nonlinear
static, staged-construction, and nonlinear direct-integration time-history load cases for
models with many Frame elements (and many load patterns) should benefit the most
especially if the analysis time is governed by state update and/or event determination.

API
Enhancements Implemented
* Ticket Description

4244 An enhancement was implemented for the Application Programming Interface in the
functions GetPreference and SetPreference for AISC 360-05, AISC 360-10, and AISC 360-16
to now allow working with the omega factors if the design provision in the preferences is set
to ASD. Previously the phi factors were always used, irrespective of the design provision
value.

6498 An incident was resolved where SAP2000 cDatabaseTables, GetTableForEditingArray could
not be called in a locked model when the table was not available for import in a locked
model.

6561 An enhancement was implemented for the Application Programming Interface (API) to add
functions for defining ASCE 7-16 wind load patterns. The API documentation was also
updated to document the functions for ASCE 7-10 wind load patterns which were already
present, but not documented.

Database Tables
Enhancements Implemented
* Ticket Description
* 5733 An enhancement has been made to speed-up the recovery of analysis results for frame

hinge response tables by means of multi-threading. In addition, new options are now
provided to control advanced parameters affecting design and response recovery under the
command Analyze > Design and Response Recovery Options: Number of Threads for Design.
Using more threads (up to number of physical cores) will speed-up design, but also uses
more RAM (memory) to be efficient. Number of Threads for Response Recovery. Using more
threads (up to number of physical cores) will speed-up response recovery, but also uses
more RAM (memory) to be efficient.
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Design – Aluminum Frame
Enhancements Implemented
* Ticket Description
* 6662 An enhancement has been implemented to add the aluminum frame design according to the

American Aluminum Design Manual 2020.

Design – Cold Formed Frame
Enhancements Implemented
* Ticket Description

6257 Enhancements have been made to the Eurocode 3 1-3 2006 Cold-formed Steel Design
including: (1) Calculation of effective partially plastic section modulus in design of sections
that have yielding that occurs first at the tension edge. In this case, the plastic reserve in the
tension zone is utilized without any strain limit until the maximum compressive stress
reaches the yield stress, and the stress distribution of the effective cross-section is bilinear in
the tension zone but linear in the compression zone. Previously, linear stress distribution
over the section was always assumed to calculate the effective section modulus, resulting in
overconservative design for the effective sections that have yielding that occurs before the
compression side reaches yield. (2) Factors Cm, C1, C2, and C3 and segment maximum
moment are now determined about principal axes for design of angle sections. Previously,
they were computed based on moments about the geometric axes. (3) Calculation of
effective section modulus about the minor principal axis for angle sections with lips.
Previously, it was computed based on the neutral axis of the gross section about the
geometric minor axis.

Drafting and Editing
Enhancements Implemented
* Ticket Description

6546 An enhancement was implemented for the Edit > Edit Lines > Divide Frame command to
now retain partial fixity assignments when dividing a frame. An assignment at the I-end of
the original frame will be placed at the I-end of the first new frame and an assignment at the
J-end of the original frame will be placed at the J-end of the last new frame.

Installation and Licensing
Enhancements Implemented
* Ticket Description
* 6492 The version number has been changed to v23.2.0 for a new intermediate release.

Results Display and Output
Enhancements Implemented
* Ticket Description
* 1846 An enhancement has been implemented to update the performance-point calculations for

pushover curves to follow the guidelines in ASCE 41-13. This was previously released in
v22.2.0 but inadvertently omitted from the release notes. The corresponding
documentation has been added to this release.

User Interface
Enhancements Implemented
* Ticket Description

6152 An enhancement was implemented to add the three Draw Link commands to the draw
toolbar.

6408 An enhancement was implemented to allow the name of imported frame section properties
to be modified in the frame property definition form.
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Analysis
Incidents Resolved
* Ticket Description
* 6486 An incident was resolved where, if a nonlinear load case or stage continued from a previous

load case or stage that had large unbalanced forces in the frame element due to nonlinear
hinges being present, the unbalance in the frame element could grow larger and/or prevent
the load case from reaching convergence. This issue only affected SAP2000 v22.2.0 to
v23.1.0. This issue only occurred in models where the analysis model for nonlinear hinges
(Analyze menu > Analysis Model for Nonlinear Hinges) was set to "Model Hinges within
Elements" and could affect nonlinear static, staged construction, and nonlinear direct-
integration time-history load cases. When the issue occurred, it would manifest as a
significant difference in frame element and hinge results between the zeroth (0th) step of
the affected load case or stage and the final step in the previous load case or stage. This
difference could also be present in global force results such as a base reactions and section
cuts. In models affected by this issue, the error could be reduced by using more load or time
steps in the previous load case or stage to reduce the frame element unbalance at the end
of that previous load case or stage. This error was not common because significant hinge
nonlinearity is not common in predecessor load cases.

6534 An incident was resolved where the mass-proportional damping defined in the material
properties (Define menu > Material Properties) that apply to a truss member could include
spurious values for the rotational degrees of freedom at the joints of the truss member. A
truss member is a frame object with all moments and torsion released, no end offsets, and
the default insertion point at the centroid of the section. This error rarely affected results
since rotational degrees of freedom are normally not present at joints connected to truss
members. Where affected rotational degrees of freedom were present, the effect on the
model was generally insignificant compared to other dynamical forces. Affected load cases
include direct-integration and frequency-domain time-history, steady-state, and PSD types.
Mass-proportional damping in modal (FNA) time-history load cases was not affected.

API
Incidents Resolved
* Ticket Description

4866 An incident was resolved for the Application Programming Interface (API) in the cross-
product interface (CSiAPIv1.dll) where the function RespCombo.GetCaseList would generate
an error when used to retrieve the case list for a load combination that included no load
cases or combinations. No results were affected.

6473 An incident was resolved where the API function GetTableForEditingArray was returning the
field names included instead of the field keys included.

6667 An incident was resolved where an error occurred in the API function
cDatabaseTables.GetTableForEditingArray when attempting to access the Auto Seismic
database tables.

6706 An incident was resolved for the Application Programming Interface (API) where the
cDatabaseTables function SetTableOutputOptionsForDisplay could not be used to set
correspondence-type results for load combinations. This issue prevented the
GetTableForDisplay functions in cDatabaseTables from outputting correspondence-type
results.

Data Files
Incidents Resolved
* Ticket Description

6612 An incident was resolved where importing a model text file (.S2K, .$2K) containing an auto
seismic load pattern defined as user loads would not be imported if the additional
eccentricity (AddEcc) field contained a negative value. A negative value is valid and can now
be imported. Results agreed with the model as imported.
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Database Tables
Incidents Resolved
* Ticket Description

6094 An incident was resolved to fix duplicate field names that were incorrectly reported when
users imported their own table and/or field names using the command Options > Database
> Set Current Table Name Source.

6559 An incident was resolved where attempting to import data into a corrupt file caused an
error.

Design – Aluminum Frame
Incidents Resolved
* Ticket Description

6800 An incident has been resolved for the American Aluminum 2015 frame design in which: (1)
The radius of gyration of the minor principal axis for angle sections is now calculated
correctly. Previously, it was not correct. (2) The flexural compression stress Fb of pipe (or
round tube) sections is calculated properly for the limit state of elastic buckling (Lambda >
Lambda_2). Previously, it was not correct. (3) Factor Cb is determined to be 1.67 for the
design situation in which Mmax produces compression on the larger flange and the smaller
flange is also subjected to the compression in the unbraced length. Previously, Cb was set to
be 1.67 when the smaller flange was checked to be in compression over the entire span of
the element. (4) Buckling/bending axes are determined appropriately for angle sections
based on the assignment specified in the lateral bracing option before checking for lateral-
torsional buckling slenderness. Previously, the bracing condition due to the bracing
assignment in the lateral bracing option was not checked for angle sections.

Design – Steel Frame
Incidents Resolved
* Ticket Description

6111 An incident was resolved where clicking on the cancel button during member design would
not cancel the design operation.

6784 An incident was resolved for the Chinese 2018 steel frame design in which the design
preference "Ignore Beam PhiB" was being applied to all members, not just beams.

6856 An incident has been resolved in the steel frame design codes AISC 360-16, AISC 360-10,
AISC 360-05/IBC2006, AISC-ASD89, AISC-LRFD93, AASHTO LRFD 2007, API RP2A-WSD2000,
API RP2A-WSD2014, API RP2A-LRFD 97, AS 4100-1998, CSA S16-09, CSA S16-14, KBC 2009,
and KBC 2016 where the expression of Beta_w was wrong, causing inaccurate evaluation of
moment capacity for the limit state of lateral-torsional buckling of angle sections with
unequal legs.

Documentation
Incidents Resolved
* Ticket Description

6562 An incident was resolved in the API documentation where the DistType parameter for the
AreaObj.GetLoadUniformToFrame function was missing from the function definition. This
was a documentation issue only.

6616 An incident was resolved that corrected Equation 3.8 in the "Material Time-Dependent
Properties" Technical Note documentation. This was a documentation issue only and did not
affect the analysis results.

Drafting and Editing
Incidents Resolved
* Ticket Description

6788 An incident was resolved where replication when joints had advanced local axes specified
could result in an error.
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External Import and Export
Incidents Resolved
* Ticket Description

6661 An incident was resolved where certain SAP2000 models could not be exported to
Perform3D and an error condition was reported.

Graphics
Incidents Resolved
* Ticket Description

6294 An incident was resolved where in DirectX graphics mode and using Named Displays would
sometimes result in an error condition. This was related to View Limits.

6699 An incident was resolved where in certain instances the uniform area load resultants display
would include an arrow but not a value.

Installation and Licensing
Incidents Resolved
* Ticket Description

6709 An incident was resolved where a message was not shown when using legacy licensing and a
Network or Standalone license was unable to be obtained at startup. Now a message is
shown indicating that a license was not found. Cloud licensing was not affected.

Loading
Incidents Resolved
* Ticket Description

6785 An incident was resolved where the default value of 0.02 second was being used as the time
step for base time history when performing spectral matching. This only affected time
histories read from files that had the acceleration data in time-value format.

Results Display and Output
Incidents Resolved
* Ticket Description

6276 An incident was resolved for displaying design results using the Show Ratio Values Above
option where values were not displayed if the displayed text contained multiple ratios or
other non-numeric characters. This was a display issue only and did not affect design results.

6623 An incident was resolved where the response spectrum curve, generated from a joint time
history through Display > Show Response Spectrum Curve command, may not be shown in
the correct units.

* 6691 An incident was resolved where the shell soil pressures displayed graphically could be
incorrect if springs were applied to the shell that were not in the normal direction of the
shell. Also if multiple spring assignments were made to the same shell the soil pressure table
would be unavailable due to an error condition. The springs were all applied correctly in the
analysis and all other results were unaffected by this error.

* 6753 An incident was resolved where requesting to generate a response spectrum at a joint from
a time history case would not account for the coordinate system specification. The results
were always given in the joint local coordinate system. For the usual case where the joint
coordinate system was not overwritten the results were in the global coordinate system.
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Structural Model
Incidents Resolved
* Ticket Description

6715 An incident was resolved where applying the Do Not Allow Hinges To Drop Load hinge
overwrite assignment (Assign menu > Frame > Hinge Overwrites) to a frame object did not
prevent Parametric P-M2-M3 hinges from having strength loss. This issue has been resolved
and the Do Not Allow Hinges To Drop Load hinge overwrite assignment will now disable
strength loss in Steel and Concrete Parametric P-M2-M3 hinges.

User Interface
Incidents Resolved
* Ticket Description

6291 An incident was resolved where the hinge assignment form for an auto idealized flexural
hinge is not displayed correctly after changing the selection from Tables in ASCE-41-17
Concrete Columns to Idealized Flexural Hinge.

6668 An incident was resolved where an error was generated when attempting to open the
Advanced SAPFire Options form with the user interface translated to Chinese. This did not
affect the user interface in English or other languages.

6696 An incident was resolved where the Curved Frame Geometry form did not fully load when
the user interface was translated to a non-English language.

6762 A incident was resolved related to the form “Force-Deformation Data for Parametric Steel P-
M2-M3 Hinge” for steel parametric hinges specified with Curve Shape “Elastic Perfectly
Plastic” and Strength Loss “Dependent on P”. The M3 backbone curve displayed on the form
with P level set to “P lower (PL)” did not correctly show the Force/SF value at point C to be
the same as point B. This was a display issue only for this form. The correct values were used
for analysis, and results were not affected.

6780 An incident was resolved where the OK/Cancel buttons may not be visible in the Load Case
Definition form when defining a frequency domain time history with advanced load
parameters.


